
AstroImageJ User Guide 

Introduction 
AstroImageJ (AIJ) is simply ImageJ (IJ) with some customizations to the base code and a packaged set of 
astronomy specific plugins. The plugins are based on the Astronomy Plugins package written by Frederic 
V. Hessman et al. of Inst. f. Astrophysik, Georg-August-Universität Göttingen. The AstroImageJ 
customizations are by Karen Collins (karen.collins --- at --- insightbb.com) and John Kielkopf of the 
University of Louisville. The application is open source, and the source code is embedded within the ij.jar 
file and the Astronomy_.jar file. To report bugs or suggest new features, please email Karen Collins at the 
address indicated above. 

Installation 
Java must be installed on a computer before running AstroImageJ. Java can be downloaded from: 

http://www.java.com/en/download/manual.jsp 

AstroImageJ can be downloaded from: 

http://www.astro.louisville.edu/software/imagej/astronomy/index.html 

Linux Installation 

Download AstroImageJ for Linux from: 

http://www.astro.louisville.edu/software/astroimagej/index.html  

and extract "AstroIJ_x.x.x.tar.gz" to the desired ImageJ folder. A script file is available that shows how to 
set up AIJ for easy start-up under Linux. For Linux installation, refer to the readme file at the 
AstroImageJ website. For more information on running generic ImageJ with Linux, go to: 

 http://rsbweb.nih.gov/ij/docs/install/linux.html. 

Windows Installation 

Download AstroImageJ for Windows from: 

 http://www.astro.louisville.edu/software/astroimagej/index.html 

and extract "AstroIJ_x.x.x.zip" to the desired ImageJ folder (ex: C:\Program Files (x86)\ ). An ImageJ.exe 
program is available in the upper most directory and can be used to start AstroImageJ. If preferred, one 
can set up a file type to be automatically opened by ImageJ.exe when double clicked by referencing that 
file type to the ImageJ.exe program. For more information on running generic ImageJ with Windows, go 
to: 

http://rsbweb.nih.gov/ij/docs/install/windows.html. 
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Mac OS X Installation 

Download AstroImageJ for Mac OS X from: 

 http://www.astro.louisville.edu/software/astroimagej/index.html 

and click on "AstroIJ_Mac_x.x.x.zip" to extract the ImageJ folder. Move this folder to the Applications 
folder, open it, and copy either ImageJ or ImageJ64 to the dock. ImageJ runs in 32-bit mode using Java 
1.5 (Java 1.4 on OS X 10.3) and ImageJ64 runs in 64-bit mode using Java 1.6. ImageJ64 is not limited to 
1800MB of memory but it requires a 64-bit Intel Mac running Mac OS X 10.5 or later. The 
"AstroIJ_Mac_x.x.x.zip" file can be deleted.  For more information on running generic ImageJ with Mac 
OS X, go to: 

http://rsbweb.nih.gov/ij/docs/install/osx.html. 

Using AstroImageJ 

AstroImageJ Control Window 

When AstroImageJ is opened, you will see the main ImageJ control window shown in Figure 1 with 
seven AIJ-specific icons on the right side of the toolbar starting at the button shown depressed below. The 
toolbar can be used the same as for generic IJ, but for most operations with AIJ, you will want the “star-
field” icon depressed as shown below (The icon is called “Astronomy Tool” in the menubar). This mode 
is referred to as astro-mode in this document. AIJ defaults to this mode at startup.  

NOTE: although the right-hand portion of the toolbar can be customized as with generic IJ, it is 
recommended to leave the default AIJ icons installed as shown below when using the AIJ version.  

Figure 1. ImageJ Toolbar with AstroImageJ tools to the right 
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AstroImageJ Image Display Interface 

When a FITS image (or any other native IJ image type) is opened, the image will be displayed in a 
window as shown Figure 2. The menubar, the data fields and buttons at the top, and the histogram and 
associated data fields at the bottom are specific to AIJ. The custom AIJ display can be disabled by 
deselecting the checkbox under the Preferences menu labeled “Use astro-window when images are 
opened”. Then close and reopen the image to use the standard IJ image display with no controls or menus. 
To reenter the AIJ style image display, make sure that the star field icon is depressed, and then click on 
the image. To re-enable AIJ style image display for all opened images, check the Preferences menu “Use 
astro-window when images are opened” checkbox. 

Figure 2. AstroImageJ Image Display Interface 

   



Important Notes Regarding AIJ vs. IJ User Interface 

This user guide assumes that an image is displayed in the AIJ interface shown in Figure 2 above and with 
the astro-mode icon selected on the ImageJ toolbar as shown in Figure 1 above. In the default mode, all 
images are opened in this state. If any of the IJ specific tools are selected (the icons to the left of the astro-
mode icon), operation will revert to standard IJ operation. Clicking back on the astro-mode icon will 
revert to AIJ operation.  

A three button mouse with a scroll wheel and separate middle mouse button, such as the Logitech 
Anywhere MX mouse, provides the most convenient and efficient AIJ operation.  

Data Displayed Above the Image 

AIJ displays several data fields above the image that contain information specific to the mouse location 
within the image. All of these values update as the mouse is moved. Two pixel coordinate systems are 
displayed in the interface. IJ’s native origin (i.e. x,y = 0,0) is at the top left of the image with “x” 
increasing to the right and “y” increasing toward the bottom. IJ pixel coordinates are useful when using 
some of the built-in IJ features. The FITS standard origin is at the bottom left of the image with “x” 
increasing to the right and “y” increasing toward the top. Pixel coordinates based on the FITS standard are 
often needed by astronomers and are particularly important when working with images with World 
Coordinate System (WCS) headers. There is also an additional 0.5 pixel offset between the two 
coordinate systems. IJ designates the top left of a pixel as the (X.0, Y.0) location while FITS designates 
the center of a pixel as the (X.0, Y.0) location. AIJ displays pixel coordinates for both of these systems on 
the first and third lines of data above the image. The middle line displays RA and DEC when WCS 
headers are available from a FITS file.  The top right box labeled “Value” indicates the pixel value under 
the mouse cursor. The “Peak” value indicates the highest pixel value within a circular aperture, while the 
“Int Cnts” value displays the sum of all the pixel values within the circular aperture. The “Int Cnts” box 
label changes to either “Length” or “Arclen” to report length in pixels or arclength in decimal or 
sexagesimal format when the mouse is being dragged with the middle mouse button depressed. 
Sexagesimal format can be selected/deselected in the Preferences menu. If WCS headers are available or 
if the pixel scale of the image has been set under the Preferences menu, arclength will be displayed. 
Otherwise, distance in pixels will be displayed. The length data can be written to a log window and saved 
if desired by selecting the corresponding option in the Preferences menu. 

Contrast/Brightness Adjustment 

Under the Preferences menu, select either auto brightness & contrast (based on the image’s pixel value 
standard deviation), fixed brightness & contrast (keeps the same user defined levels from image to 
image), or full dynamic range (displays the full range of pixel values in the image). The selected option is 
saved and recalled when new images are opened or a new image is displayed in a stack. The “black” and 
“white” values indicated below the histogram can be directly entered in any mode, but if auto mode is 
selected, they will update when the image is updated or another image is opened. The “min” and “max” 
histogram values are normally automatically set to the min and max pixel values of the displayed image. 
However, the values can be directly entered and will not change from image to image if the Preferences 
menu item “Use fixed min and max histogram values” is enabled.  

AIJ provides a number of ways to adjust the contrast and brightness of an image. The simplest way is to 
click the “Auto Scale” button above the image. If auto-scale does not provide the desired result, the 



arrows in the histogram can be dragged left and right to adjust the image display. The currently displayed 
range of pixel values is shown in blue in the histogram. The blue region can be dragged with the mouse to 
adjust the brightness. The pixel value corresponding to black is indicated in the histogram “black” box, 
and the pixel value corresponding to white is indicated in the “white” box. These numbers can be directly 
modified by clicking on an existing number and typing a new value and pressing <Enter>. Alternatively, 
a right mouse drag in the image will control the image brightness/contrast similar to DS9. When right-
click dragging, watch the histogram to see how the motion affects the settings. Moving up and down 
moves the range of values displayed up and down similar to dragging the blue region in the histogram. 
Moving right and left increases and decreases the width of the displayed range. Alternatively, pressing the 
shift key while rolling the mouse wheel adjusts the image brightness and pressing the control key while 
rolling the mouse adjust the contrast. 

Panning 

Left click and drag the mouse to pan the image.  

Zooming 

If using a mouse with a scroll wheel, the wheel can be used to zoom in and out of the image. Place the 
mouse cursor at the point in the image where the zooming should take place and roll the wheel. If a 
mouse wheel is not available, click in the image at the desired zoom point and use the zoom buttons 
above the image, or press "control" and left click to zoom in, or "control" and right click to zoom out. 
Press the “In x8” button above the image or double left click to zoom in “fast”. Double right click to 
zoom out such that the image will fill the available area in the image display.  Press “Fit” or triple right 
click to zoom out such that the full image is displayed on the screen (which may leave white space at top/ 
bottom or left/right of the image). 

Measuring Length 

A middle mouse button click and drag shows distance in arclength in the bottom right box at the top of 
the image when a pixel scale is set in the Preferences menu or WCS headers are available. Otherwise 
length is shown in pixels. Middle click on the image to remove the line that was drawn during the 
measurement. Two Preference menu options are available to enable image data to be written to a log file 
when the middle mouse button is clicked or dragged. The resulting log file can be saved if desired. 

Single Aperture Photometry 

AIJ offers a “live” photometer which follows the mouse pointer around in the image and provides a peak 
pixel count and an sky subtracted integrated count for a defined aperture. The photometer radius and inner 
and outer background radii can be set in the Edit menu after selecting aperture settings. Display of the 
photometer can be disabled by unchecking the Preferences menu item “Show photometer regions at 
mouse cursor”. The photometer peak and integrated counts will be updated above the image even if the 
photometer annuli are not showing. The display state of the photometer annuli can be temporarily 
inverted by pressing the Shift key while rolling the mouse. 

Shift click is a shortcut to access the full single aperture photometer which is also available on the IJ 
toolbar (the first icon to the right of the astro-mode icon). The single aperture photometer will provide full 
aperture photometry data which is displayed in a MeasurementsTable and can be saved or plotted. The 



data values reported can be set in the Edit menu Aperture Settings selection or by double clicking on the 
single aperture tool on the IJ toolbar. Apertures displayed on the image can be removed by double middle 
clicking or by clicking the “broom” icon on the IJ toolbar. 

FITS Header Access 

The "Header" button above the image displays the fits header in a separate text window. The Edit menu 
“FITS Header” option will allow FITS header editing by hand, but currently will not save the new setting 
back to the image. 

Using an Inverting Lookup Table 

AIJ can display an image as a “negative” by selecting the “Neg” button above the image. AIJ uses an 
inverting lookup table to display the image rather than modifying the underlying image. 

Regions of Interest  

Several items in the Analyze menu require a region of interest (ROI) to be defined within an image before 
running that selection. The most commonly used ROI shapes are oval, rectangular, and line. ROIs can be 
drawn by clicking on the related icon on the IJ toolbar, however, astro-mode panning and other 
convenient mouse functions will be lost while the ROI is being drawn. If you use the IJ toolbar, 
remember to click on the astro-mode icon when you are finished to restore astro-mode functionality. 
Short cuts are available to draw these three common ROI shapes without leaving astro-mode. Press and 
hold <shift> while left dragging to draw an oval ROI. Press and hold <control> while left dragging to 
draw a rectangle ROI. Press and hold <alt> while left dragging to draw a line ROI. To move or edit an 
existing ROI, press and hold the <tab> key, then use the mouse to point at the ROI and drag it to the new 
location. To edit the shape of an ROI, hold the <tab> key and hover the mouse cursor over one of the ROI 
selection points until it changes to a finger shape, then click and drag to change the ROI shape. Currently, 
to modify some ROIs, it may be necessary to set the image orientation to “Invert None” and “0 degrees” 
under the View menu. It may be quicker to simply redraw the ROI using the shortcuts described above. 
This issue will be resolved in a future AIJ release. ROIs can be cleared by either  using the View menu 
“Clear Overlay” selection or a middle mouse click will clear any ROIs. 

Menus in the Image Display 

Pull-down menus are provided at the top of the image display to allow direct access to many features 
commonly used by astronomers.  

File menu: provides several options for opening and saving image, stack, and MeasurementTable files. 
The first image will need to be opened from either the OS or the IJ toolbar File menu. Subsequent images 
can be opened from the AIJ File menu, the OS, or the IJ toolbar File menu. 

Preferences menu: provides several options for changing how an image is displayed. When an image is 
closed, its preference settings are saved to ImageJ memory. If multiple image windows are open and the 
preference settings in more than one window have changed, the settings of the last window closed are 
saved over any other previously saved settings. Preference settings are not saved to hard disk until AIJ 
closes, so if AIJ crashes or is terminated improperly (using something like “killall imagej” in Linux), the 
settings will not have been updated in the IJ_Prefs.txt file for use the next time ImageJ is started. Also, if 



AIJ is closed from the IJ toolbar while an image is still open, any preference changes will not be saved 
when IJ closes. The best practice is to close all images before closing the IJ toolbar. 

View menu: provides several options for setting the displayed orientation of an image and for enabling 
informational overlays. The “Clear Overlay” option clears any apertures or ROIs drawn on the image, but 
not the informational overlays. 

Edit menu: provides options to edit various data associated with an image or stack. These options include 
editing of aperture settings, IJ measurement settings, FITS header entries, and stack configuration. 

Process menu: provides various tools to modify the data within an image. 

Analyze menu: provides several options to measure the data within an image and to plot and/or save those 
results. 

Zoom Status and Image Orientation Indication 

The zoom status and image orientation graphical information can be overlaid at the top left corner of the 
image as shown in Figure 2. The outer blue rectangle represents the size of the image and the inner blue 
rectangle represents the part of the image that is current displayed in the window. The red arrows indicate 
the north and south directions in the image. Currently, the orientation of these arrows must be set by the 
user under Preferences menu. The setting indicates the number of degrees the arrows are rotated in a 
counter clockwise direction from standard north = up, east = left position. Eventually, if WCS headers are 
available, the north and east arrow directions will be set automatically, but for now, all images require the 
manual setting. The green X and Y arrows indicate the orientation of the X-Y axes in the standard FITS 
coordinate frame. These arrows change direction according to the View menu invert and rotation settings. 
If an image is oriented as “Invert None” and “0 degrees”, the Y-direction will be up and the X-direction 
will be to the right. The overall zoom indicator size can be set under the Preferences menu. The View 
menu provides three options to enable or disable each component individually. 

Data Reduction Interface 

Overview of Operation 

To start a data reduction session, click the DP (Data Processor) icon on the IJ toolbar or use an image’s 
Process menu “Data Reduction Facility” selection if an image is already open. Figure 3 below is an 
example setup that would process 148 WASP-12b images, first creating a master bias from files in the 
same directory as the science images, but that start with “bias_” and end with “.fits”, similarly creating a 
master dark, but using a master flat that has previously been created and exists two directories up in a 
"cals" directory. Wildcards are allowed in filename specifications with “?” representing any single 
character, and “*” representing any number of characters. RA and DEC of the target and latitude and 
longitude of the observatory are required if calculations of altitude/airmass/HJD are desired. Check “Use” 
to calculate these values and check “Save” to add the values to the output file’s FITS header. The 
processed files are placed in a subdirectory called "pipelineout" in this case and each file has the suffix 
“_bsdf” added (i.e. bias subtracted, scaled for non-linearity, dark subtracted, and flat-fielded). 

A key field to set up is the polling interval at the bottom right. When set to "0", all matching files in the 
specified directory when the script is started will be reduced and then the process will stop. If set to any 



other number, the "Primary Directory" will be polled at that interval (in seconds) for new incoming files 
after all of the initial files have been processed. This mode is useful for monitoring for the arrival of new 
images from a camera and provides for the capability of near real-time light curve plotting during an 
observing session. 

When all fields are setup as desired, click the "Start" button to begin processing. Any specified master 
calibration files will be created first, followed by the science image processing. If STOP is pressed, 
processing will pause after the next image reduction has been completed. Press "Reset" to start over, or 
press "Continue" (the "Start" button will now be labeled "Continue") to finish processing without starting 
over. 

Note: Most options and fields in the Data Processor interface have generous tooltips available to explain 
the feature’s operation. Hover the mouse over a field to see its tooltip. To keep it displayed longer while 
reading lengthy tooltips, move the mouse back and forth slowly over the field after the tooltip has been 
displayed. 

Figure 3. Data Processor Interface 

 
 

Data Reduction Algorithms 

The data reduction algorithm in general executes the check boxes that are enabled starting from the top 
left and advancing toward the bottom right check box. 

For master bias, dark, and flat usage, click “use” next to the corresponding label to use a pre-existing 
master calibration file that is defined by the “Relative Directory” and “Filename Pattern” to the right. 



Click “use” and “create” to build a new calibration file using files in the specified “Relative Directory” 
that match the specified “Filename Pattern”. The master file is created in the same relative directory with 
the filename specified in “Master Filename”. Make sure that the proper number of files is displayed under 
the “#” symbol for each category before starting the run. Each calibration file can be created using either 
an average or a median of the individual images by selecting “ave” or “med”, respectively. 

Master Bias: when create is selected, the specified images will be average or median combined to create 
the master bias file specified. The use of a master bias is not required in general, but is required for 
exposure time scaling and non-linearity correction.  

Master Dark: when create is selected, the specified images will be average or median combined to create 
the master dark file specified. If “use” master bias is selected, the resulting master dark image will be bias 
subtracted using the previously generated or specified master bias image. If “use” master bias is not 
selected, the master dark will not be bias subtracted. If “use” non-linearity correction is selected (“use” 
bias must also be selected), the bias subtracted dark is scaled using the three specified non-linearity 
coefficients. 

Master Flat: when create is selected, the specified images will be processed and average or median 
combined to create the master flat file specified. If “use” master bias is selected, each individual flat is 
bias subtracted before combining. If “use” master dark is selected, each individual flat is dark subtracted 
before combining. If “use” is selected for both bias and dark, the flat is both bias and dark subtracted 
before combining. For “dark exposure timing scaling” to be applied when creating the master flat, “use” 
master bias and master dark must both be selected and either created or available, and “Dark ExpTime 
Scaling” must be selected. Selecting it without selecting “use” bias and “use” dark will result in no dark 
exposure time scaling. The full flat-field creation algorithm first bias subtracts each flat image (if 
selected), scales the pixel values by the non-linearity coefficients (if selected), dark subtracts the resulting 
image (if selected), removes any gradient from the image (if selected near the bottom), and normalizes the 
image to an average value of 1.0. After all specified flat images have been processed in this way, the 
resulting images are either average or median combined to create the master flat-field image. 

Processed Images (Science Images): after any selected master calibration files have been created, each 
science image matching the “Primary Directory”, “Filename Pattern”, and “Filename Number Filter” 
settings defined at the top of the window are processed according to the “use” values selected. To “use” 
dark exposure time correction, it must be selected, and “use” must be selected for both master bias and 
master dark. The full science processing algorithm first bias subtracts each image (if selected), scales the 
pixel values by the non-linearity coefficients (if selected), dark subtracts the resulting image (if selected), 
and then divides by the master flat (if selected). If “Cosmic Ray Removal” is selected, outlier pixels in the 
image are replaced by the average of its four neighbors. Cosmic ray removal is not suggested for use with 
photometric data since it can clip steep peaks of stars. The selection of “gradient removal” does not apply 
to science images. If “Save” processed images is selected, the new file will be written to the specified 
relative directory with the specified suffix added in either 16-bit integer or 32-bit float format, as selected. 
The filename format can be any natively supported image file type (such as .fits, .tif, .jpg, .gif, .bmp, etc.).  

“Show Log” displays a list of the steps completed in a log window. This data can be saved for reference if 
desired. “Show Master Images” shows the master calibration creation process as it progresses and 
displays the final master calibration files. However, this option uses more memory. The “Auto Level” 



selections can be ignored since this function is now implemented as an option in the image display 
window.  

Real Time Light Curve Plotting 

The macro options near the bottom provide the capability to perform “real-time” data reduction and light 
curve plotting during an observing session. To use this feature, select “use” Macro 2 checkbox and then 
browse to the IJ plugins directory on your computer. Then navigate to the Directory_Watcher folder and 
select MultiApertureOnly.txt as the macro file. This macro runs Multi-Aperture (see Multi-Aperture 
section below for description) after each new image arrives and has been calibrated. After the first file has 
been calibrated, the Multi-Aperture setup window will be displayed, allowing any number of aperture 
locations to be selected in the image. After then final aperture has been selected, Multi-Aperture runs 
differential photometry on the image and creates a MeasurementsTable containing the results. Then the 
macro opens Multi-Plot and plots the light curve as set up in the Multi-Plot interface (see below for 
details). After the first image is completed, each subsequent image is processed automatically. Multi-
Aperture uses the same relative aperture positions without intervention. Each aperture is repositioned at 
the centroid of the corresponding star in the new image, unless the image field moves by more than the 
aperture radius from one image to the next, in which case the process is halted. The plot is automatically 
updated after Multi-Aperture has completed photometric measurements and has updated the 
MeasurementsTable.  

IMPORTANT: As long as the light curve plot is displayed, the Multi-Aperture settings dialog is bypassed 
and the previous aperture locations are used as reference. If new Multi-Aperture settings are desired, close 
the light curve plot window and the settings dialog will be display for the next image that is processed. 
Since a new set of Multi-Plot control windows will be opened when a new plot is generated, the old 
Multi-Plot control windows should be closed as well. All the settings will be saved and restored to the 
same state when the plot windows are opened. If you want to start the run over with new data for all 
images, close the MeasurementsTable window as well. Otherwise, new measurements will be appended 
to the old measurements. 

Single Aperture Photometry 
To perform single aperture photometry in astro-mode, hold the <shift> key and left-click near the object 
to be measured to place an aperture at its centroid. Alternatively, photometry mode can be entered by 
clicking on the IJ toolbar “Aperture Photometry Tool” icon to the right of the astro-mode icon. In 
photometry mode, left-click (without holding <shift>) near an object to be measured to place an aperture 
at its centroid. The photometric results will be written to a MeasurementsTable that will be created and 
displayed after creating the first aperture. 

The parameters of the photometer and the data recorded in the MeasurementsTable can be set up by 
double clicking the single aperture icon on the IJ toolbar. If an image is open, the settings can be accessed 
under the Edit menu “Aperture Settings” selection. There are many options available but figures 4 and 5 
below show an example of settings that should be a good starting point. Adjust the aperture sizes properly 
for the data being analyzed. Be sure to select “Show other configuration panel” to display the second set 
of options after the first set is closed. 



Figures 4 and 5. Aperture Photometry Parameters 

  
 
 

Multi-Aperture Photometry 
Multi-aperture photometry provides the capability to run a series of photometric measurements on 
multiple objects within an image and to repeat those measurements for a sequence of images. Before 
starting Multi-Aperture photometry, an image stack needs to be opened. A stack is a sequence of images 
opened into a single AIJ or IJ image display window. To open a stack, if an image is already displayed, 
go to its File menu and select “Open sequence in new window”. Otherwise, go to the IJ toolbar and select 
File/Import/Image Sequence. Using either method, select the directory containing the images to be 
opened. After pressing open, you will see the dialog shown in Figure 6 below. 



Figure 6. Open File Sequence Options 

 
 
Define a file name pattern that is unique to the image set that is to be processed. In the case above, there 
are 292 images in the directory, but by entering "xo" in the "File name contains" field, the number of files 
to be opened has been reduced to 258 as can be seen at the bottom. An important checkbox here is the 
"Use Virtual Stack" field. If this is checked, AIJ loads only one image at a time into memory. If this is not 
checked, one needs to have enough memory in the computer, and allocated to IJ, to open a "stack" of 
images that totals the number of MB shown at the bottom (16512 MB in this case). After pressing OK, 
the image display will open (this may take some time if not using a virtual stack). Note the addition of the 
scroll bar below the bottom of the displayed image. The scroll bar allows the user to move through the 
stack to inspect each image individually. When moving the scroll bar, the display of a virtual stack 
updates more slowly than non-virtual stacks due to hard disk access time. 

To perform multi-aperture photometry, click the icon with two apertures on the IJ toolbar (second icon to 
the right of the star-field icon). The dialog shown in Figure 7 will be displayed. 



Figure 7. Multi-Aperture Setup Dialog 

 
To process a full stack of images the first time, set up the options as shown above and make sure the 
“Maximum number of apertures per image” setting is higher than the number you will need. The aperture 
size must have been previously set using the image’s Edit menu “Aperture Settings” selection or by a 
double click of the single aperture icon as described in the Single Aperture Photometry section. The 
"Vary photometer aperture radii based on FWHM" check box and the associated FWHM multiplier can 
be used rather than a fixed aperture size. In this mode, the aperture will vary based on an estimate of the 
FWHM of the target star. This option is particularly useful when seeing is changing dramatically 
throughout an observing sequence. As a starting point, use a multiplication factor of 1.3 x FWHM and 
adjust based on the data being processed. 

After pressing OK, go to the image display, and click on or near the target star. An aperture will be drawn 
in green at the centroid of the star. Next click on the comparison stars one after another and more 



apertures will be drawn in red. When an aperture has been placed at the last star of interest, right click to 
start processing. After the first image has been processed, a table will be displayed with a row that 
contains the photometric results. The next image in the sequence will then be displayed and the apertures 
will be re-centered based on the new centroids of the stars of interest. The centroid operation will fail if a 
star has moved by more than the aperture radius from image to the next. If the image shift is greater than 
the aperture radius, single step mode is available, which requires clicking only the target star in each 
image, to give a new offset reference. To use this mode after a centroid failure, check "Use previous 
apertures" and "Use single step mode" in the Multi-Aperture dialog. After clicking on the target star in the 
new image, new apertures will be drawn using the relative spacing from the previous image. After 
verifying that the apertures are centered properly, click on the image again to advance to the next image. 
Erroneous rows in a Measurements table can be deleted by selecting the row and using Edit/clear or right 
click/clear. 

NOTE: The “Allow double click fast zoom in/out” option in the Multi-Aperture setting dialog enables the 
user to left double click on an image to zoom in by a factor of 8 at that point, and to right double click to 
zoom-out and fit the image to the window. Enabling the option can speed aperture placement, but it does 
introduce a slight delay in drawing a new aperture on the screen, and can take some practice to perform 
the right double click reliably. The double clicking option can be particularly confusing to a new user, and 
should be disabled until one gets familiar with the clicking combinations. 
 
Once photometry on the full sequence is complete, a "Measurements" table will be displayed as shown in 
Figure 8 below. The data can be saved in tab delimited format by using the File/Save as ... command at 
the top of the data window. 

Figure 8. Measurements Table 

 



Light Curve Plotting 
 
To plot a light curve and/or other data, make sure a MeasurementsTable is open in AIJ, and then open the 
main Multi-plotting window by either using an image display’s Analyze menu “Multi-plot” selection or 
click on the light curve plotting icon on the IJ toolbar (4th icon to the right of the astro-mode icon). The 
main plot settings window will be displayed as shown in Figure 9 below.  

Figure 9. Main Plot Settings Window 

 
 
Most of the fields (or the labels above a column) on this and the following window have "tool tips" that 
pop up if the mouse is hovered over them which describe the use of the item. If a second plot settings 
window does not display automatically, press "OPEN" "Y-data Columns" near the top left of the main 
window and a second window will be displayed as shown in Figure 10 below. 



Figure 10. Y-datasets plot settings  

 
If a large screen (1920 x 1080 or larger) is available, the Plot_IJ_Main/Preferences/"use wide Y-data 
columns" option can be enabled to display all Y-data options for each plotted curve in one continuous row 
as shown in figure 11 below. 

Figure 11. Wide Y-data options display mode  

 
"Auto" and "Custom" are radio buttons that enable one of two plotting modes for each data set. "Auto" 
scales the data set to fit onto "Scale %" of the displayed image and shifts it to "Shift %" of the displayed 
image, whereas "Custom" sets an absolute scaling and shifting. However, in this mode the curve may not 
end up on the plot if it does not fall within the displayed Y-axis range. 

The mathematical “Operator” feature allows calculations to be performed on one column of data using 
data from a second column, with the result being plotted. For example, as set up in dataset number two 
above, the target net integrated counts (Source-Sky) is divided by only the first comparison star’s net 



integrated counts (Source-Sky_#2), where as the first dataset (ratio1) is a column in the table that 
represents the target counts which have already been divided by the total of all the comparison star counts 
by the Multi-Aperture application. Since the data table contains only the ratio of the target to the 
combination of all the comparison stars (i.e. ratio1), the "Operator" feature can be used to easily check for 
the non-variability of comparison stars, etc.  

To zoom in on the plot window, left click it. To zoom back out, right click it. It is easy to inadvertently 
zoom in on the plot when left clicking the window to bring it to the front. Plotting will be changed in a 
future release to change this behavior. For now, click on the edge or top of a plot window to select it 
without zooming in. On Linux systems, the plot zooming feature does not work properly at this time. The 
settings shown above result in the multi-curve plot shown in Figure 12. 

Figure 12. Multi-Curve Plot Produced by AstroImageJ 
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